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1. Para quién es el Manual 

 
Al iniciar un proyecto de desarrollo - en un lugar y contexto desconocido - involucra 
ciertos obstáculos, siendo uno de los más críticos el desconocimiento del sistema o 
red social existente es decir la estructura y características de las relaciones que 
forman las personas o instituciones con su entorno. 
 
Necesariamente los investigadores deben comprender este sistema para identificar 
con quiénes y cómo se va a trabajar, así como comprender las relaciones que existen 
entre los diferentes actores. Cuando se trabaja en estructuras sociales desconocidas 
existe un alto riesgo de tomar decisiones erradas, por lo que es importante invertir 
cierto tiempo para identificar a los actores claves y entender las relaciones sociales 
existentes entre ellos. Asimismo, establecer alianzas con socios que gozan de buena 
aceptación en el sector incrementa las posibilidades de éxito para cualquier proyecto. 
 
En ese sentido, este manual será una herramienta útil para identificar estos socios 
ideales, visualizar la compleja red social que se teje en cualquier región y así 
informarse del contexto social en le cual va a trabajar para planificar de mejor 
manera las acciones necesarias. 
 
El manual está dirigido a organizaciones, centros de investigación, profesionales, 
académicos u otra gente con un conocimiento previo de informática, interesados en 
redes sociales y que estén trabajando en desarrollo rural.  Este documento muestra 
paso a paso cómo realizar gráficos de redes sociales que permitan dar un vistazo 
general de algunos escenarios y, de esta manera, facilitar la planificación de un 
proyecto, mediante la identificación de actores clave dentro de un entorno 
determinado. 

2. Introducción al Análisis de Redes Sociales (ARS) 

 
La metodología del análisis de redes sociales (ARS) ha demostrado tener un alto 
crecimiento dentro de las ciencias sociales y hasta el momento se ha aplicado en 
temas tan diversos como salud, psicología, organización empresarial y comunicación 
electrónica. La aplicación en el área del desarrollo rural es bastante nueva y se espera 
que este manual ayude a que esta herramienta sea más accesible para las personas 
que trabajan en este campo. 
 
El concepto de estas redes, se muestra cada vez mas frecuente en la vida cotidiana, 
ya que las personas se encuentran cada vez mas conectadas entre sí, y  es cada vez 
más común el trabajo  que se hace de forma virtual sin necesidad de encontrarse en 
un espacio físico. Mientras estas redes van creciendo, existe cada vez mayor 
conciencia de la importancia de las relaciones sociales en todos los ámbitos, o sea 
redes virtuales desde empresas internacionales hasta comunarios que viven en una 
aldea remota en las montañas quienes buscan encontrar un mercado para sus 
cultivos.   
 
Para comprender estas relaciones se ha desarrollado el Análisis de redes sociales, que 
cuenta con dos enfoques principales, los actores y las relaciones que existen entre 
ellos en cierto contexto social. Estos enfoques ayudan a comprender la influencia de 
la posición en que un actor se encuentre dentro la red para tener acceso a los 
recursos como bienes, capitales e información. Asimismo surgiere que la actividad 
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económica esta relacionada con las estructuras sociales, idea que ha creado el 
concepto de capital social.    
 
Uno de los recursos que fluye por la red es la información, y el ARS ha sido aplicada 
para identificar los flujos de información así como los cuellos de botella. En teoría la 
identificación de los flujos y cuellos de botella debe llevar a mejores estrategias para 
compartir información entre diferentes actores, basado en las estructuras existentes, 
buscando de esta manera incertivarlos y no remplazarlos. 
 
Para acceder a recursos los actores forman vínculos con otros actores, formando 
clusters en los cuales las personas que están mejor posicionadas estarán mejor 
informadas. Los actores con variedad de fuentes de información normalmente 
pertenecen a varios clusters, lo que les da cierto poder al tener un rol de 
intermediación hacia las personas que no tienen tantos contactos y por lo tanto 
acceso a información. Cabe recalcar que los flujos no son necesariamente equitativos, 
lo que crea jerarquías basadas en las posiciones que los actores tienen dentro de la 
red. 
 
Las redes no solamente proveen acceso a recursos sino que a otros actores que 
pueden ayudar a dar valor a esos recursos. Se sugiere que algunos actores 
estructuren sus redes sociales para obtener un máximo provecho, aproximándose 
cada vez mas a los recursos y oportunidades existentes.  La inversión en las 
relaciones sociales para acceder o movilizar recursos con la intención de generar 
ingreso económico se llama construcción de capital social. Se habla mucho de este 
concepto pero de forma muy abstracta; el ARS es una herramienta que puede ayudar 
a entender mejor como las relaciones sociales pueden influir en el desarrollo local.  
 
Al existir mucho trabajo para encontrar mecanismos que permitan utilizar el ARS 
como un insumo para crear capital social, se espera que un primer paso sea la 
posibilidad de, al menos, visualizar las relaciones que existen entre los diferentes 
actores que interactúan en cualquier contexto. Desde esta perspectiva aún existe un 
largo camino para fortalecer las relaciones sociales y así crear condiciones más 
equitativas para los productores rurales que no están bien conectados a las redes 
donde fluyen los recursos y se toman las decisiones.  Sin embargo se espera que 
permita a la gente entender como funcionan estas estructuras, así como su posición 
relativa en el marco de la red.     
 
Se ha escrito mucho sobre el análisis y la teoría de redes sociales que puede ser de 
interés para algunas personas, sin embargo este  no es el ámbito para hablar más de 
este tema. La idea de este manual es proporcionar las herramientas necesarias para 
realizar un análisis de su propia red social a personas con ninguna experiencia 
previa, y permitirles adaptar la metodología según sus propias necesidades. 
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3. Utilidad del ARS para los Diagnósticos  

 
Normalmente los estudios en el ARS cuentan con uno de dos enfoques: el primero 
enfoque en un grupo cerrado, por ejemplo las personas quienes trabajan en una 
organización y se estudia las relaciones que existe entre ellas, o el segundo, se toma 
una persona y se busca entender las relaciones sociales que existe en su entorno.  En 
el contexto del desarrollo rural, ninguno de estos enfoques es el más adecuado dado 
que sería demasiado costoso entrevistar a todos los actores que trabajan en cierta 
zona y las tecnicas asociadas para estudiar las redes personales no se adecuan muy 
bien al nivel institucional, dado que no hay tanta transparencia entre las relaciones 
inter-institucionales como entre las personas. Además hay que analizar las relaciones 
existentes entre individuos e instituciones y para entender los procesos de innovación 
es preciso visualizar los flujos e intercambios de información y conocimiento entre 
ambos niveles a la vez.   
 
Los proyectos de desarrollo rural operan en un marco socio-institucional muy 
complejo, donde se ven interacciones entre organizaciones de base, organizaciones no 
gubermentales, instituciones publicas y privadas, las cuales puedan operan al nivel 
local, regional, nacional o internacional.  Esta heterogenidad se complica aún más en 
un escenario donde la cooperación internacional tiende a trabajar con proyectos de 
corto a mediano plazo con alianzas entre varios socios, lo que limita las posibilidades 
de la continuidad y consolidación de experiencias exitosas. 
 
La metodología del análisis de redes sociales aplicada como una herramienta de 
diagnóstico puede ayudar a enfrentar los desafios associados con la planificación e 
implementación de proyectos de desarrollo rural, demostrando las tendencias 
institucionales, identificando iniciativas similares para evitar la replicación de 
esfuerzos y facilitando la construcción de capital social entre los diferentes actores. La 
visualización de redes sociales a nivel de comunidades y organizaciones permite 
comprender las redes locales mostrando las  interacciones entre actores y las 
personas con influencia.  
 
Los mapas creados por esta herramienta tienen mucho potencial a la hora de 
informar acerca de la realidad. Los sociogramas o grafos visuales deben poder captar 
la atención e imaginación de los actores rurales donde el nivel de alfabetismo es a 
veces muy bajo, lo que ocasiona la falta de interés en participar en investigaciones o 
leer informes escritos. Los mapas ayudan a personas ajenas a la localidad a 
identificar los actores centrales de la red local, lo que es una buena guía al momento 
de decidir quienes involucrar en un proyecto, o al menos con quienes consultar 
durante los procesos de planificación con la esperanza de involucrarlos en procesos 
de planificación y implementación de proyectos para que xista mejor participación y 
apropriación de las innovaciones.  El insumo visual, también es un buen punto de 
partida para estimular la discusion entre los actores claves, de sus relaciones y los 
beneficios de trabajar en forma colaborativa para construir una red que funcione 
hacia objetivos comunes.   
 
La gran variedad de actores y cantidad de temas que cruzan en el contexto del 
desarrollo rural no se debe ver como factor limitante a realizar un estudio ARS, más 
bien estos factores son precisamente lo que da tanto valor al ARS como herramienta 
diagnóstico y brinda resultados rapidos, visuales y altamente útiles para la gente que 
trabaja en este tema.    
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4. Haciendo el Análisis de Redes Sociales  

 
En el análisis de redes sociales, los gráficos se forman por dos tipos de información:  

1) los nodos que representan a las personas o instituciones y  
2) los vínculos, o sea las distintas relaciónes entre los actores o nodos. 

 
Uno de los problemas en cualquier contexto social es que los actores no son 
homogéneos y es importante distinguir entre distintos grupos de actores.  El ARS da 
la posibilidad de definir entre los grupos diferentes, los cuales tienen atributos que 
representan sus distintas características.  Estos atributos pueden referirse al estrato 
social (ricos, pobres), nivel de educación, actividad economica, sexo, etc. Y en el 
gráfico se pueden representar por distintos colores o formas.  
 
Con respecto a los vínculos, éstos se refieren a diferentes tipos de relaciones que 
quieran medirse. En el caso de este manual hemos tomado como ejemplo el flujo de 
información entre los distintos actores en una cadena productiva, en este caso de café 
en Bolivia. Sin embargo, se espera que el ejercicio se puede aplicar con otros 
enfoques, por ejemplo flujos de ideas, bienes o cultivos para mostrar distintos tipos 
de relaciones en una variedad de contextos sociales. 
 
Cuando se piensa en la realización de un análisis de red para establecer diagnóstico 
los mas importante es tener bien claro qué información se quiere obtener. Esta 
herramienta es muy versátil para visualizar relaciones sociales pero hay que subrayar 
que tiene ciertas limitaciones y la utilidad del estudio dependerá en cierto grado en la 
claridad de las ideas desde un comienzo. Antes de empezar es muy importante pensar 
exactamente qué atributos de los actores nos interesan, así como los tipos de 
relaciones que se quieren presentar con los gráficos.   
 
Otro elemento que hay que pensar bien es el tamaño de la muestra.  La investigación 
debe identificar una muestra óptima en un estudio de esta naturaleza.  Lo importante 
es tener una muestra suficientemente representativa para que el gráfico muestre las 
tendencias e identifique tanto a los actores más importantes como a los que se 
encuentran aislados, teniendo el cuidado de no tomar una muestra demasiado 
grande que resulte en grafos muy complejos y dificiles de descifrar.  
 
Una vez definidas las relaciones sociales y atributos de los actores que se quiere 
mapear, se elabora una encuesta con una muestra representativa de los diferentes 
tipos de actores.  
 

1 Paso 1: Diseño de la encuesta 

Es recomendable formular preguntas  puntuales, sobre todo si el estudio se lleva a 
cabo en zonas rurales con pequeños productores de tal manera que puedan 
responder en forma concreta, que no confunda ni lleve mucho tiempo. Anteriores 
experiencias con encuestas de estructura más tradicional han mostrado que la gente 
tiende a aburrirse respondiendo muchas preguntas. El objetivo de esta herramienta 
es obtener la máxima información en el menor tiempo posible, brindando resultados 
que permitan al investigador obtener un panorama general del escenario.   
 
En este sentido puede formar parte de una encuesta que abarque otros temas 
independientes a las relaciones sociales y utilizar sus resultados independientemente.  
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Como en todo tipo de encuesta el investigador debe pensar en cómo hacer las 
preguntas, utilizando un lenguaje sencillo que no sea malentendido por los 
encuestados. Además hay que pensar en el tipo de respuestas que se espera y como 
se van a codificar. Hay dos opciones; hacer preguntas abiertas o cerradas.   
 

1.1 Preguntas abiertas 

Existen muchas ventajas en hacer preguntas abiertas donde las personas tiene 
libertad de responder espontáneamente. De esta manera, los prejuicios de 
investigadores, en muchos casos extranjeros, no se interponen tanto en el estudio, y 
los resultados realmente reflejan la perspectiva de la gente entrevistada. Sin embargo, 
es importante considerar que esta manera implica una mayor inversión de tiempo 
una vez recolectados los datos, y que es el mismo investigador quien va a aplicar su 
criterio, agrupando y codificando las respuestas. 
 

1.2 Preguntas cerradas 

Preguntas cerradas anticipan todas las respuestas posibles y las agrupan antes de 
salir al campo, para que en el momento de llenar la encuesta solo haya que utilizar 
un simple código evitando recordar muchas respuestas que alargan el tiempo 
requerido para la entrevista. Si bien de esta manera se pierden ciertos detalles de la 
información recopilada, hay que tomar en cuenta que se ahorra bastante tiempo a la 
hora de hacer el análisis.   
 
Por otra parte, la mayoría de los investigadores tienen experiencia previa en el tema y 
poseen cierta capacidad para predecir las respuestas que se van a producir, 
permitiendo la opción de una categoría abierta (Otro, por favor especifique). 
 
La decisión de cual de estos métodos utilizar dependerá del criterio del investigador y 
los fines del estudio. Es importante analizar este punto ya que se corre el peligro que 
todas las respuestas caigan en una misma categoría lo cual a futuro no permitirá 
hacer un completo análisis.   
 
 Las preguntas sobre los atributos como las preguntas sobre los vínculos es un tema 
que debe tratarse con especial cuidado.   
 

1.3 Definiendo los variables 

Se debe tener cuidado al hacer demasiadas preguntas con el fin de no dejar de lado 
ningún elemento o dato relevante. Si bien es importante reconocer la importancia de 
ser metódico, es muy común que el investigador se encuentre frente a datos inútilies 
a la hora del análisis; el mismo notará que no puede analisar todo por la cantidad de 
datos recopilados o que tiene datos que no dice nada nuevo.  Hay que subrayar que 
esta herramienta es para hacer un diagnóstico muy general de las relaciones sociales 
en cierto contexto y no entrar en mayor detalle. Por eso se recomienda que se limite el 
número de variables tanto para los atributos como para los variables, tomando como 
guía dos o tres de cada tipo.   
 
La idea es que el mapeo sirva como elemento de diagnóstico y que se puede analizar 
posteriormente con mayor detalle con los actores identificados. De esta manera el 
investigador estará mejor preparado para realizar entrevistas que tomen en cuenta 
temas relevantes. Asimismo, se espera que los actores estén dispuestos a conversar la 
situación real presentada en los mapas. 
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El ejemplo tomado para este manual es sobre la cadena del café,  una gran cadena, 
con muchos actores. El enfoque del estudio fueron los flujos de información entre los 
distintos actores de la cadena. La variable clave de los atributos fue el papel de cada 
persona dentro de la cadena distinguiendo entre productores, asociaciones, 
comerciantes, servicios de apoyo etc.  Para los vínculos se han establecido dos 
variables claves: el tipo de información (por ejemplo manejo de cultivo, precios, 
comercialización) y los medios de comunicación utilizados para trasmitir esta 
información entre actores (por ejemplo teléfono, internet, radio etc). 
 

1.4 El formato de la encuesta 

 
1.4.1 Información de atributos 
La información de atributos permite distinguir entre los diferentes tipos de actores 
que aparecen en el gráfico. Ejemplos de atributos que agrupan personas son el papel 
desempeñado en la cadena, nivel de educación, acceso a recursos, etc. Los mismos 
pueden estar relacionados, citando como por ejemplo el tamaño del terreno y el 
volumen de producción.  
 

Es muy importante que las preguntas sean sencillas y codificables. 
 

1.4.2 Información de vínculos 
Con los vínculos hay que tener clara la relación que se quiere medir. A cada relación 
se le asigna un color al momento de graficar, para que se pueda apreciar en el dibujo 
de la red. 
 
El ejemplo presentado en este manual utiliza vínculos para mostrar distintos tipos de 
flujos, tipos de información o de medios de comunicación.  La estructura de la 
encuesta para levantar esta información se ve en la tabla 1. 
 
 
Tabla 1: Encuesta para levantar flujos de información 
Actor en la cadena Tipo de información Medio de comunicación 

   

   

   

 
 
 
 

 
Cabe señalar que también se puede dar un valor numérico a las relaciones, por 
ejemplo cuantas veces se contacta por semana, utilidad o confiabilidad percibida de 
la información obtenida.  La estructura de una encuesta para levantar esta 
información se ve en la tabla 2. 
 
Este formato corresponde a usos mas tradicionales del ARS, en que se puede medir la 
fuerza de los vínculos entre los distintos actores 
 
Tabla 2: Encuesta que da valor a los flujos de información 
Persona, organización o 

institución 
Tipo de Información 

Utilidad de la información 
(escala: 1 min - 5 max.) 

  1       2       3       4       5 

  1       2       3       4       5 

  1       2       3       4       5 
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Una última decisión que hay que hacer en este paso es cuántas respuestas por actor 
entrevistado.  Se puede poner un limite donde se supone que los actores nombrados 
serían los más importantes o se puede dejarlo abierto a ver cuántas personas están 
nombrados, como por ejemplo, fuentes de información.  Esta ultima opción tiene la 
ventaja de que así se puede no solamente identificar cuales actores estan más 
nombrados pero también quienes nombran a más personas, surgeriendo que estas 
son las personas que tienen más contactos y son más conscientes de su entorno. 

2 Paso 2: Levantamiento de Información 

Cuando la encuesta esta lista hay que pensar en cómo se va a levantar la información 
y quien va a hacer el trabajo de campo. Hay muchos elementos logisticos y 
metodológicos a considerar en esta etapa. 
 
Entre los temas logísticos están los recursos humanos y financieros disponibles para 
realizar el estudio. Para cualquier estudio, el tiempo y el dinero siempre son factores 
limitantes y el investigador tiene que decidir si la información va a ser recopilada por 
su cuenta o si se van a contratar encuestadores, lo que implicará darles capacitación 
en el uso de la herramienta y el propósito del estudio.  No hay respuestas definitivas a 
estas preguntas y variará mucho entre cada estudio. 
 
En lo metodológico también se deben tomar ciertas decisiones que permitan definir el 
alcance del estudio, lo que tendrá muchas implicaciones para que éste tenga 
representatividad en las relaciones sociales y su contexto. 
 
Primero, es clave definir los límites geográficos del estudio, es decir las localidades 
donde se van a levantar encuestas.  Implícito en este factor se encuentran 
consideraciones logísticas, como la accessibilidad a comunidades remotas, así como 
los costos de viaje. Si el estudio se lleva a cabo en varias comunidades o municipios 
es importante definir si habrá un encargado responsable o un equipo con 
representantes en distintas localidades. 
 
Segundo, es necesario definir la muestra que quiere tomar. Hasta el momento no se 
puede decir cuál es el número adecuado que permita realizar un estudio de este tipo, 
pero nuevamente se debe enfatizar que utilizar el análisis de redes es una 
herramienta de diagnóstico que permitirá dar una idea de la realidad cuyo objetivo no 
es entrar en mayores detalles.  Si se va a recopilar información de diferentes grupos, 
como por ejemplo en diferentes comunidades, o con distintos papeles en la cadena, es 
importante que la muestra sea representativa de todos estos grupos.  
 
Finalmente se debe decidir dónde empezar. Lo recomendable es empezar la encuesta 
con el punto de contacto en la zona de estudio quien va enlazando con sus otros 
contactos que estn trabajando en el mismo rubro.  Los contactos nombrados en esta 
encuesta ya son actores que se desean entrevistar utilizando técnicas de la bola de 
nieve, para así, ir creando un mapa de las relaciones existentes.   Sin embargo, para 
tener una visión más amplia de las relaciones sociales es recomendable partir de más 
de un actor.  
 
Cuando se trabaja con productores, quienes normalmente están dispersos hay que 
pensar bien en representatividad ya que ellos tienen redes en sus comunidades y a la 
vez pertenecen a otras redes más grandes donde interactuan directamente con 
instituciones.  
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Este tema metodológico es muy interesante ya que en este tipo de estudio se ven las 
relaciones e interacciones de individuos con instituciones, y aunque hay que pensar 
en cómo mostrar de la mejor manera las relaciones entre estos dos grupos diferentes, 
se debe mostrar el funcionamiento real entre los diferentes actores. Se sugiere en el 
momento de graficar la red que las personas y las instituciones se distingan por 
figuras diferentes. 
 

3 Paso 3: Preparando el Base de datos 

Una vez realizadas las encuestas, estas se deben transferir a una base de datos 
(Excel). Es un trabajo en el que se debe tener mucho cuidado (existen ventajas entre 
una encuesta de preguntas abiertas frente a una de preguntas cerradas).  
 
Se deben elaborar dos bases de datos: una, con la información sobre los nodos y sus 
atributos, y otra, con los datos de los vínculos. Es más fácil empezar con la base de 
datos de vínculos porque nos va a servir para elaborar la base de datos de los nodos. 

3.1 Codificación  

En cada encuesta hay una lista de nombres y la información correspondiente.  Si se 
han dejado preguntas abiertas, es el momento de sistematizarlas y codificarlas.  Se 
recomienda no tener más de 10 tipos de información en cada categoría.  
 
En el caso de utilizar los vínculos para mostrar distintos tipos de flujos, todos los 
datos tienen que ser codificados y numerados, por ej.   
 

Información  Medio  

Certificación 1 Visita 1 

Manejo del cultivo 2 Teléfono 2 

Riego 3 Celular 3 

Manejo Pos cosecha 4 Fax 4 

Clima 5 Internet 5 

Transformación 6 Correo 6 

Precios 7 Talleres 7 

Desarrollo empresarial 8 Radio 8 

Mercados  9 Video 9 

Otro  10 Afiche 10 

3.2 Crear un base de datos de los vínculos  

En esta parte hay que trabajar en Excel y crear una base de datos con cuatro 
columnas (Figura 1):  En este caso los cuatro columnas son:  

1) Actores entrevistados (se repite el nombre del entrevistado por cada actor     
que ha nombrado),  
2) Actores nombrados,  
3) Tipo de información  
4) Medio con la cual se accede a esta información.   
 

Las primeras dos columnas serán lo mismo en cualquier estudio y las ultimas dos 
columnas variarán según los variables que uno ha escogido para su estudio.  
También es posible tener más columnas con más datos si se ha decidido tener más 
variables a la hora de diseñar la encuesta.  Es muy tentador, pero siempre hay el 
riesgo de enfocar demasiado en los detalles y perder la vista más amplia del 
escenario. 
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Los mismos dos actores pueden tener más de un vínculo,  
lo que representa que fluye más de un tipo información  
entre ellos.   
 
 
 
 
 
 
 
 

 
 

Figura 1: Trasladar las encuestas a una base de datos  excel 

3.3 Crear un base de datos de los atributos 

 
La base de datos que se hizo con los vínculos contiene todos los actores que aparecen 
en la red y facilita la creación de la base de datos de los atributos de los nodos (Figura 
2), que requiere hacer una lista de todos los actores en la red.   
 

 
 
 

 

 
 
 

Se abre una nueva hoja excel.  Se copian las dos listas de 
actores (entrevistados y nombrados ) de la base de datos 
por los vínculos.  Se pegan las dos columnas en una sola, 
lo que genera una lista extensa con muchos actores 
repetidos. 
 
 
 
 
 
 
 
 

Figura 2: Preparar la lista de actores para la  base de datos de atributos 
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3.4 Elaborar una lista de todos los actores que aparecen en la red 

 
 
 
Para borrar los nombres repetidos, ir a Data – Sort – 
Ascending.  Así se organizan los nombres en orden 
alfabético y será más fácil identificar cuáles están 
repetidos.  Esta acción también permite identificar si 
hay actores que aparecen con nombres diferentes, lo 
que puede traer problemas al momento de trasladar 
los datos al software.  Se borran los nombres 
repetidos (Figura 3), hasta obtener una lista 
depurada de todos los actores. 
 
 
 

Figura 3: Borrar actores repetidos 

 

 

3.5 Llenar los atributos de los nombres  

 
 
 
 
 
Con esta lista de nombres se formará la base de datos 
de los atributos de nodos.  Para ello se aumentan 
columnas (Figura 4) y se va introduciendo la 
información de los atributos.  
 
 
 
 
 

Figura 4: Base de datos de atributos 

 

 
En este caso hay 4 columnas:  

1) ID que es el nombre que aparecerá en el gráfico (y tiene que corresponder con 
la información de la base de datos de los vínculos).  

2) Nombre completo, por ejemplo de las organizaciones de Productores 
3) Tipo de actor (productores, asociaciones, instituciones, etc.) 
4) Ubicación geográfica de los actores. 

 
Hay que recordar que este es una lista completa de todos los actores que aparecen en 
la red, tanto los entrevistados como los nombrados.  Por lo tanto es posible que no 
tiene información de atributos para todos los nombrados, porque es muy 
probablemente porque no se les ha entrevistados todos.  Hay que decidir qué hacer 
con los nodos sin atributos, o se puede llenar los datos de información previa o 
fuentes secundarias o se puede llenar con sin_dato.  No debe dejar vacía ninguna 
celda. 
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También se hace las siguientes recomendaciones:  

• Utilizar nombres cortos para no complicar el gráfico. 

• Escribir los nombres sin espacios.  
 
Por ej. Gobierno Municipal = Gob_mun (ahora mucho tiempo en el siguiente paso) 

 
Cuando ya están completas las bases de datos hay que adecuarlas para entrarlas al 
software. 

4 Paso 4:  Preparando el Base de Datos para traslado a Netdraw 

4.1 Eliminar las hojas vacias  

 
 

 

 
 
Culminado el paso anterior se graba como archivo  .txt 
(Figura 5). (Tomar en cuenta que excel permite grabar 
como txt sólo si hay una hoja (normalmente un archivo 
se abre con tres hojas; por lo tanto hay que eliminar 
las dos que están vacías). 
 
 
 
 
 

Figura 5: Borrar hojas vacias 

4.2 Grabar el archivo como .txt 

 

 

 
 
 
En este paso hay que guardar los dos archivos en formato 
.txt (fig 6).  Para hacer esto ir a Save as, cuando abre la 
ventana, tiene la opción de guardar en una variedad de 
formatos (Save as type).  Dar el archivo un nombre y 
escoge Text (tab delimited) (*.txt)  
 
 
 
 

Figura 6: Guardar como .txt 

4.3 Abrir los archivos de nodos y vínculos en Notepad. 

Una vez gravado como txt, se debe abrir nuevamente el archivo en Notepad para 
hacerle unos ajustes que se necesitan para posteriormente introducirlo en el 
programa graficador de redes (Netdraw). 
 
Se cuenta entonces con dos archivos, uno de atributos (Node Data) y otro de vínculos 
(Tie Data) (Figura 6). Estos dos archivos deben ser fusionados. Primero se abre el 
archivo de atributos (en txt) y se dan dos pasos importantes: (También es posible 
hacer esto mientras esta en excel todavía) 
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Se empieza con la información de atributos. Se abre el archivo correspondiente (en 
.txt) y se dan dos pasos importantes: 
 
La primera línea aumenta *Node Data. 
 
Se debe verificar que la segunda línea tenga los nombres de las columnas (los 
atributos), siendo en este caso: 

 
ID  nombre  tipo de actor  ubicación  

 
 

4.4 Poner todos los nombres con más de un componente entre comillas 

 
 

 

 
 
Si existen espacios en alguno de los nombres, estos 
deben ir entre comillas. Por ej. “Actor de Apoyo”. Es 
un trabajo exhaustivo, que requiere paciencia, pero 
muy importante (Figura 7).  Si los datos no están 
entre comillas el software considerará cada palabra 
como una información diferente. 
 
 
 
 

Figura 7: Preparar los datos para el software 
 
 
La base de datos de vínculos tiene que pasar por el mismo proceso (fig 8) para que el 
programa Netdraw lo pueda reconocer aunque en este caso la primera línea tiene que 
ser *Tie Data.  
 
De la misma manera en la segunda línea (que serían las relaciones) deben estar las 
relaciones correspondientes, siendo en este caso: 

 
ID  actor  información   medio 
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También se debe verificar aquellos datos con múltiples palabras 
que están entre comillas. 
 
 
 
 
 
 

 

 

Figura 8: Alistar los datos de vínculos 
 

4.5 Adjuntar los archivos de atributos y nodos 

 
El siguiente paso es adjuntar los datos de nodos y atributos en un solo archivo 
(copiar y pegar).  La información de los atributos (*Node Data) debe ser la primera 
seguida por la información de vínculos (*Tie Data).  No se deben dejar líneas en 
blanco. 
 

 
 
Es posible guardar en un solo archivo desde la etapa en 
excel, según lo prefiera el usuario. A veces hay que 
ajustar los datos para buscar errores por lo que se 
recomienda trabajar los dos archivos separados para 
facilitar la tarea de encontrar un dato erróneo.   
 
 
 
 
 

Figura 9: Adjuntar los archivos de atributos y nodos 

 

 
Cuando ya está lista la información es recomendable grabar bajo un nuevo nombre. 
Ya están listos los datos para introducirlos al Netdraw.  
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5 Paso 5: El uso del Software Netdraw 

 

¿Qué es Netdraw
♣? 

 
Netdraw© es una herramienta de software para graficar, la cual se puede bajar gratis 
del Internet en la siguiente dirección: http://www.analytictech.com/netdraw.htm 
 
Netdraw está cambiando constantemente con considerables mejoras. Este manual 
está basado en la versión 2.29 (bajado el 9 de febrero de 2006). 
 
Netdraw lee archivos en varios formatos –este manual se basa en el formato .vna que 
es el más sencillo de convertir de una hoja de excel. 
 
El programa no es muy pesado y, por lo tanto, se baja en poco tiempo. El mismo tiene 
un manual básico (en inglés). 

5.1 Abriendo el archivo en Netdraw 

Una vez instalado, se abre y aparece una nueva pantalla. Vaya a Open y aparecen 
varias opciones. Escoja Vna Text File y, luego, Complete (Figura 10). 
 

 

 
Figura 10: Abrir el archivo en Netdraw 
 

 
   

Unidos los datos de vínculos y atributos 
tenemos toda la información en un solo 
archivo. Se lo busca (Figura 11) y abre en esa 
ventana. 
 

 Figura 11: Encontrando el archivo 
 

Aparece una ventana con dos 
columnas. En la primera se 
marca .vna,  y en la otra, Network 
with Attribute (Figura 12). 

 
 

 
Figura 12: Definiendo el tipo de archivo 
 

                                                 
♣  Borgatti, S.P. 2002. Netdraw: Graph Visualization Software. Harvard Analytic Technologies 
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Luego aparece la primera imagen de red (Figura 13). 
 

 
Figura13: La primera red  

 
Si no aparece como lo muestra la figura 13 significa que existe algún problema con 
los datos y tienen que revisarlos. 

5.2 Dando forma a la red 

Posteriormente se da un poco de orden; entonces se va a  

Layout →  Graph-theoretic Layout →  Spring Embedding (Figura14). 
 

 
        Figura 14: Estructurando la red I 

 
Aparece la siguiente ventana (Figura 15) y se da OK. 
 

 
        Figura 15: Estructurando la red II 

 
Se aprecia un gráfico más fácil de leer (Figura16). Estos pasos se pueden repetir 
hasta tener un gráfico mas claro. También se puede jugar con otros efectos que se 
acomoden a los gustos visuales del usuario.   
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Hay que mencionar que este manual no pretende explicar el significado de todas las 
acciones, ni como funcionan, lo que sí quiere dar es una guía sencilla para crear 
sociogramas sin enfrentar muchas dificultades. 
 

 
                            Figura 16: Ajustando los nodos sueltos en la red 
 
Es posible en esta instancia que aparezcan algunos nodos sueltos (Figura 16). Puede 
tratarse de un error (un acento, un espacio, una letra que sobra o falta, etc.). 
También es posible que sean nodos que no están conectados a ningún otro en la red. 
Para comprobarlo hay que volver al archivo .txt y revisar cuidadosamente. Estos 
ajustes son normales y hay que tener paciencia hasta lograr el gráfico correcto 
(Figura 17). 
 

 
                           Figura 17: Imagen de la red 

5.3 Dando color a los nodos 

Si se desea cambiar el color de los atributos se va a  
 

Properties → Nodes→  Color → Attribute Based (Figura18). 
.  

 
                                             Figura 18: Dar color a los nodos 
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Se abre la siguiente ventana (Figura 19) donde aparecen 
los atributos que se han grabado en la base de datos. 
 
 
 
 

Figura 19: Escoger el atributo a mostrar 

 

 
Para cambiar de color se debe escoger el atributo que se desea destacar. Para este 
ejemplo, se escoge Tipo de actor. Aparece una ventana con distintas opciones de 
colores (Figura 20) para los distintos atributos de los actores que se han identificado. 
El escoger diferentes colores permite hacer una mejor lectura del gráfico. También se 
pueden cambiar los colores haciendo doble click sobre el Actor en la ventana de ´Color 
Nodes by Attribute´. 
 

 
                              Figura 20: Definir los colores de los nodos 

5.4 Dando color a los líneas 

 
Existe la opción de cambiar el color de las líneas (Figura21) para diferenciar distintos 

tipos de relaciones (en nuestro caso, información). El paso es: Properties → Lines → 

Color → Tie Strength.  
 

 
                                   Figura 21: Cambiando el color de las lineas 
 
En la ventana que aparece (Figura 22) se escoge la información (valores) que  se desea 
colorear.  
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                            Figura 22: Escoger cual de los vínculos se va a colorear 
 
Así aparece el gráfico que muestra las relaciones sociales en la red (Figura 23). 
 

 
                                  Figura 23: Red con vínculos y nodos colorados  
 
También es posible aumentar el grosor de los vínculos, pero solo si están codificados 
entre 1 a 5, como es el ejemplo de la segunda encuesta arriba.   
 

Para ello, vaya a Properties→ Lines→  Size → Tie Strength (Figura 24). 
 

 
                                       Figura 24: Mostrar la fuerza de los vínculos 

5.5 Primeros análisis de la red 

La vista general es muy compleja, pero existe la posibilidad de visualizar grupos de 
actores y, de esta manera, realizar un análisis más sencillo. 
 

 

 

En la ventana de la derecha de la pantalla (Figura 25) vaya a Nodes 
que muestra los distintos grupos por su atributo. En este ejemplo, se 
escoge Productores  
 
 
 
 
 
 

Figura 25: Seleccionar grupos de  nodos 

 21



Si se borra la señal de un grupo desaparece temporalmente del gráfico, como en este 
ejemplo de los productores. (Figura 26).  Así se pueden visualizar distintos grupos y 
cruzar acorde con las necesidades de análisis.  
 

 
                                    Figura 26: La red sin un grupo de actores 
 
Para que la información vuelva a aparecer se presiona nuevamente sobre las cajas 
vacías en la ventana de la derecha o en el botón  ~Del de la barra de herramientas 

 

 

 

 
 
 
 
También se puede hacer esta selección con los vínculos. El 
procedimiento es similar: En la ventana de la derecha, donde dice 
Relations, se escoge el tipo de información que se quiere mostrar 
(Figura 27). 
 
 
 
 
 
 

Figura 27: Seleccionar vínculos 
 
A continuación, en la siguiente ventana se elige el valor de la relación según como se 
la haya codificado (Figura 28). 
 

 
Figura 28: Mostrar vínculos individuales 

Hay las opciones: 

> 
> 

≥ 
= 

≤ 
< 
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Al quitar alguna de las relaciones van a quedar nodos sueltos, porque ya no están 
vinculados con los demás. Se los puede dejar o se pueden esconder. Para escoger esta 
opción, se va a la barra de herramientas y presiona sobre el botón Iso (Figura 29).  
 

 
                                      Figura 29: Esconder los nodos sueltos 
 
El gráfico que aparece muestra un cambio en la estructura de la red. Hay grupos 
sueltos, y eso significa que, por el tipo de información escogida, no les llega la 
información a través de la red.  Para volver a la información completa haga otro clic 
sobre las cajas vacías en la ventana de la derecha o en el botón ~Del de la barra de 
herramientas.  
 
Este es un análisis básico, pero esta herramienta ofrece muchas otras opciones. Es 
muy importante continuar experimentando las diferentes funciones que ofrece el 
software.  

5.6 Guardando grafos y archivos 

Es tiempo de guardar (Figura 30).  
 

 

Para guardar, se va a File → Save Diagram 
as y se escoge el tipo de archivo. En este 
programa, los gráficos se pueden grabar en 
diversos formatos, entre ellos jpeg, bitmap o 

metafile. 

 
Figura 30: Guardar el gráfico  
 

 

Si se quiere guardar toda la información, incluyendo 
colores y posiciones se escoge el formato Vna. Para 
ello vaya a File → Save Data as → Vna → Complete 
(Figura 31). 

 
Figura 31: Guardar el archivo 
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5.7 A experimentar 

Este manual es simplemente una introducción al uso de este software. Sin embargo 
es una base que permite al usuario adquirir confianza y comience a experimentar de 
acuerdo a las necesidades en su ámbito de trabajo. 
 

5 La Red de 2 Modos 

 
La Red de 2 Modos es una manera más compleja de mostrar información y en la que 
se tienen nodos de dos tipos diferentes, por ejemplo actores y sus demandas de 
información lo que permite visualizar esas relaciones y facilita el análisis.  
 
A través de un ejercicio se va a mostrar cómo hacerlo. Para efectos del mismo, se van 
a utilizar dos nodos: los Actores y las Demandas de Información, para dar un vistazo 
dónde están ubicados. Vale aclarar que los datos son simulados. 
 

Atención: Para crear estas redes de 2 modos es necesario tener el programa Ucinet©∗.  
Ya no es un programa gratis y requiere licencia.  Se puede bajar de internet en la 
siguiente dirección:    http://www.analytictech.com/ucinet.htm 
 

Paso 1 Estructura de la encuesta 

En la preparación de una encuesta para levantar información para hacer una red de 
dos nodos, aplican las mismas consideraciones mencionados arriba.  
 
La estructura de encuesta que se propone es una tabla sencilla de dos columnas. Por 
cada actor se va a tener un listado de información deseada (es decir, la información 
que les hace falta) y el medio como les gustaría recibir. Sin embargo, la tabla se puede 
ajustar según el interés del estudio. 
 

Información  deseada Medio como le gustaría recibir 

  

  

  

  

  

 
 
 

                                                 
∗ Borgatti, S.P. , M.G. Everett & L.C. Freeman. 2002. Ucinet 6 for Windows: Software for Social Network 

Analysis. Harvard Analytic Technologies 
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Paso 2: Armando el base de datos 

 
 
 
 
Eso nos lleva un base de datos de tres columnas (figura 32). En 
una está el listado de los productores encuestados, en la 
segunda columna van las demandas hechas y, en la tercera, los 
medios.  
 
 
 
 
 

Figura 32: Base de datos para red de 2 modos 

 

 
 
 

 

 
Con estos datos hay que crear una matriz. El 
primer paso es codificar los Medios en la base 
de datos anterior. Para ello se va a Tools → Sort 
(Figura 33). Sorteando los datos por la columna 
de Medios facilita mucho la tarea.   
 
 
 

     Figura 33: Ordenar el base de datos 

 

 
 
 
 
Se va sustituyendo el medio por un valor numérico y así 
se va formando un listado que facilita la tarea. 
 
 
 
 
 
 

Figura 34: Codificar la información de vinculo en una red de 2 modos 
 
Al tiempo que la información esta codificada hay que ir armando la matriz (Figura 
35).  Se ponen los actores en la primera columna, mientras en la primera fila van los 
tipos de demandas de información reconocidos. La manera más facil de hacer esto es 
ordenando las demandas de información , así se van llenando una por una las 
columnas de la matriz, con los distintos medios a los que se les ha dado un valor 
numérico (aunque también pueden ser binarios).   
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                     Figura35: Transferir la información de columnas a un matriz 

 
 

 
Figura 36: Una matriz de 2 modos en excel 

Paso 3: Traslado de los datos a Ucinet© 

El siguiente paso ya requiere abrir Ucinet©. Abre Ucinet y habrá una pantalla vacía.  
 

 
Figura 37: Abrir un matriz de Ucinet 

 

Una vez introducidos todos los datos 
se tiene una matriz como la que 
aparece en la Figura 36. 

 

Vaya a Data → Sreadsheets → Matrix. 

(Figura 37) 

Cuando esta abierto la matriz de 
Ucinet, hay que copiar la matriz 
hecha en excel y pegarla a la 
matriz de Ucinet (Figura 38). 
 

Figura 38: Copiar la matriz excel a la matriz Ucinet 
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Al abrir la ventana hay que cerciorarse 
de que estén las columnas y filas 
correctas donde aparecen las 
dimensiones Row / Col, al lado derecho 
de la pantalla (Figura 39).  
 
 
 
 

Figura 39: La matriz en Ucinet 
 
Los espacios vacíos hay que llenarlos con 0.  
Vaya a Fill → Blanks w/0s (Figura 40). 
 
 
 

 
                                           Figura 40: Llenar las celdas vacías 
 
 
 
 
 
 
 
 
 
 
Grabe el archivo (Save) (Figura 41). 
Tenga en cuenta que los archivos Ucinet 
se guardan como (.##h).  

 

 
 
 
 
 

                                                            Figura 41: Guardar el archivo Ucinet 
 
Ahora ya está listo para ir a Netdraw para poder visualizar la red. 
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Paso 4: Visualizando la matriz con Netdraw 

Utilizando Netdraw para hacer una red de dos modos es muy parecido a una red un 
modo, solo que ahora los datos estan en formato diferente.   

 

 

 
 
 
Primero abra Netdraw, vaya a  
File → Open →  Ucinet Data Set → 2 Mode 
Network (Figura 42). 
 
 
 

Figura 42: Abrir archivo Ucinet en Netdraw  
 
 
 

 

En la ventana que aparece (Open Data 
File), como lo muestra la figura 43, se 
busca la carpeta archivada y se asegura 
de escoger en File format: → Ucinet  y en 
Type of Data: 2 mode network → OK. 

 
                                                                  Figura 43: Encontrar el archivo Ucinet  

 
 

 

 

 
 
 
 
Aparece el gráfico de la red de 2 
modos (Figura 44) y se aprecian cómo 
los actores estan agrupados alrededor 
de las demandas de información.  
 
 
 
 
 
 

Figura 44: Red de dos modos 

 

 
Se puede enriquecer la gráfica con los atributos. Esto 
se hace de la misma manera que en el ejercicio 
inicial.  Los archivos .txt son compatibles con Ucinet. 
Vaya a File → Open  → Vna text file → Attributes 
(Figura45). También es posible utilizar Ucinet para 
crear un base de datos de los atributos. 

 
Figura 45: Aumentar los atributos 
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Figura 46: Encontrar el archivo correcto 
 
Una vez metida la información, se puede cambiar el color de los nodos de la misma 
forma que en el ejemplo anterior. 
 
 

        

Se abre una ventana donde 
tenemos la carpeta con el archivo 
(Figura 46). Asegúrese de escoger 
en  
File form: Vna y en Type of data: 
Node Attribute(s) → OK.  

 

Para ello vaya a Properties →  nodes 
→ color → attribute based  
(Figura 47). 

      
          Figura 47: Cambiar el color de los nodos 

 
 
 
 
En la ventana de la derecha se escoge  Nodes → 
ID, y se selecciona de acuerdo al interés Así se 
puede ver a los productores agrupados por color 
(en el ejemplo de la Figura 48 sería por la 
cantidad de vacas que poseen). 
 
 
 

Figura 48: Escoger el color de los nodos 

 

 
 
 
También se pueden esconder grupos 
según sus atributos para facilitar un 
análisis mas detallado (Figura 49). Igual 
que en el anterior, vaya a Nodes y 
seleccione el grupo de actores que quiere 
ocultar.  

 
 
 

                                                              Figura 49: Esconder grupos de nodos 
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El programa permite cambiar el color de las líneas para representar los diferentes 
valores asignados en la matriz para representar los diferentes medios a través de los 
cuales la gente le gusta recibir su información.  
 
Vaya a Properties → Lines → Color → Tie strength (Figura 50). 
 

 
                                      Figura 50: Cambiar el color de los vínculos 
 
 
Y da la posibilidad de sacar información puntual. Por ejemplo, si sólo queremos ver la 
información que se quiere recibir por radio, vaya de nuevo a la ventana derecha: 
Relations y escoja el valor asignado al medio radio (que en este ejercicio se ha puesto 
con valor numerica 6) y sólo van aparecer esas líneas.  
 
 

 

En la figura 51 se ven que algunas 
demandas de información quedaron 
sueltas. Eso significa que no hay 
demanda para recibir a través de la 
radio. Y así se puede seguir 
escogiendo relaciones, de acuerdo al 
interés del estudio. 

 
Figura 51: Seleccionar los vínculos 
 
 
 
 
 
 
La figura 52 muestra cómo queda 
la nueva estructura de la red, 
según la demanda de información 
a través de la radio.  

 

 
 
 
 

 
          Figura 52: Estructura de la red con  solo un tipo de vínculo 
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6 Herramienta versátil 

Como se dijo en un principio, el objetivo de este manual es hacer que el Análisis de 
Redes Sociales (ARS) sea accesible a muchas personas que trabajan en el desarrollo 
rural y en ambientes donde existen redes sociales muy complejas, que en ocasiones 
pueden formar barreras que frenan la intervención de los investigadores y los 
proyectos de desarrollo. 
 
Este manual se puede adaptar a las necesidades de organizaciones y personas en 
diferentes ámbitos. La diversidad de usuarios y sectores será crucial para su 
actualización.  Es una herramienta nueva en la que hay mucho por explorar y 
ensayar.  En este sentido cada usuario deberá utilizarlo de acuerdso con sus 
necesidades y intereses, buscando el mejor uso para entender las relaciones sociales 
que influyen en el desarrollo local. Cualquier aporte es importante para continuar el 
perfeccionando y validando esta metodología.   
 
Se espera que simplificando el ARS permita más acceso a un mayor número de 
usuarios de diferentes sectores, ya que es una herramienta versátil, práctica y con 
mucho potencial.  
 
Es muy prematuro llegar a conclusiones finales.  Por ahora seguimos 
experimentando.  Los diferentes actores que conforman la realidad social harán el uso 
de esta herramienta sea cada vez más diverso y permita entender y evaluar su 
utilidad.   
 
No existe una respuesta mágica ni al porqué de la pobreza ni al como del desarrollo y 
de la misma manera que este manual nos ayuda a entender las complementariedades 
y conflictos entre diferentes actores, también se espera que formará parte de la gran 
variedad de metodologías que se aplican para fomentar el desarrollo.   
 
Seguramente, los usuarios de este manual tendrán muchas preguntas sobre el ARS y 
los resultados que brinda. Deliberadamente el presente manual no menciona la forma 
de llevar adelante un análisis dejando esta posibilidad abierta para que cada usuario 
lo haga espontáneamente, leyendo los mapas desde su propia perspectiva y 
reconociendo la importancia de percibir la realidad desde múltiples puntos de vista. 
El concepto detrás de este planteamiento es que la visualización de las redes sociales 
puede ayudar a la gente a entender la complejidad de su entorno como primer paso 
hacia cambios positivos.  
 
La expectativa es que el presente manual sirva como punto de partida, dejando a la 
imaginación de cada usuario para que se guíe en el uso y adaptación de esta 
herramienta a su propio ámbito de trabajo. Suerte en sus aplicaciones. 
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